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Chapter 468

Equivalence Tests for
the Ratio of Two
Poisson Rates
Introduction
This procedure may be used to calculate power and sample size for equivalence tests involving the ratio of two
Poisson rates. This procedure includes the option of accounting for over-dispersion.
The calculation details upon which this procedure is based are found in Zhu (2016). Some of the details are
summarized below.

Technical Details
Definition of Terms
The following table presents the various terms that are used.
Group

1 (Control)

2 (Treatment)

Sample size

𝑁𝑁1

𝑁𝑁2

Individual event rates

Dispersion parameter:

𝜆𝜆1

𝜆𝜆2

𝜑𝜑 (𝜑𝜑 > 1 implies over-dispersion; 𝜑𝜑 < 1 implies under-dispersion)

Average exposure time: 𝜇𝜇𝑡𝑡
Equivalence ratios:

Sample size ratio:

𝑅𝑅𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 (𝑅𝑅𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 < 1); 𝑅𝑅𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 (𝑅𝑅𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 > 1)

𝜃𝜃 = 𝑁𝑁2 ⁄𝑁𝑁1
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Hypotheses
The equivalence test hypotheses are
𝜆𝜆

𝐻𝐻0 : 𝜆𝜆2 ≤ 𝑅𝑅𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 𝑜𝑜𝑜𝑜
1

where 𝑅𝑅𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 < 1 and 𝑅𝑅𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 > 1.

𝜆𝜆2
𝜆𝜆1

𝜆𝜆

vs. 𝐻𝐻1 : 𝑅𝑅𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 < 𝜆𝜆2 < 𝑅𝑅𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈

≥ 𝑅𝑅𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈

1

For a given equivalence test with significance level 𝛼𝛼, a two-sided confidence interval with 100(1 – 2𝛼𝛼)%
confidence is typically used. 𝐻𝐻0 is rejected if the confidence interval falls completely between 𝑅𝑅𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 and
𝑅𝑅𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 .

Power Calculation
Power Calculation
Zhu (2016) bases the power calculation on an equivalence test derived from a Poisson regression model. The
power calculation is
�𝑁𝑁1 (log(𝜆𝜆2 ⁄𝜆𝜆1 ) − 𝑙𝑙𝑙𝑙𝑙𝑙𝑅𝑅𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 ) − 𝑧𝑧𝛼𝛼 �𝑉𝑉0−

𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = Φ �

where

�𝑉𝑉1

𝑉𝑉1 =

�𝑉𝑉1

𝜑𝜑 1
1
� +
�
𝜇𝜇𝑡𝑡 𝜆𝜆1 𝜃𝜃𝜆𝜆2

and 𝑉𝑉0− and 𝑉𝑉0+ may be calculated in either of two ways.
𝑽𝑽𝟎𝟎 Calculation Method 1 (using assumed true rates)
Using Method 1, 𝑉𝑉0− , 𝑉𝑉0+ , and 𝑉𝑉1 are equal.

�𝑁𝑁1 �𝑙𝑙𝑙𝑙𝑙𝑙𝑅𝑅𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 − log(𝜆𝜆2 ⁄𝜆𝜆1 )� − 𝑧𝑧𝛼𝛼 �𝑉𝑉0+

� + Φ�

+
−
= 𝑉𝑉01
=
𝑉𝑉01

�−1

𝜑𝜑 1
1
� +
�
𝜇𝜇𝑡𝑡 𝜆𝜆1 𝜃𝜃𝜆𝜆2

𝑽𝑽𝟎𝟎 Calculation Method 2 (fixed marginal total or restricted maximum likelihood estimation)
−
=
𝑉𝑉02

+
𝑉𝑉02

𝜑𝜑(1 + 𝑅𝑅𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 𝜃𝜃)2
𝜇𝜇𝑡𝑡 𝑅𝑅𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 𝜃𝜃(𝜆𝜆1 + 𝜃𝜃𝜆𝜆2 )
2

𝜑𝜑�1 + 𝑅𝑅𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 𝜃𝜃�
=
𝜇𝜇𝑡𝑡 𝑅𝑅𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈𝑈 𝜃𝜃(𝜆𝜆1 + 𝜃𝜃𝜆𝜆2 )

Zhu (2016) did not give a recommendation regarding whether Method 1 or Method 2 should be used, except to
say that “in summary, based on scenarios simulated, all of the sample size methods derived in this paper
calculated reasonably accurate sample sizes for the intended power. Although some methods seemed slightly
better than the others for some scenarios, the sample size differences were very small relative to the actual sample
sizes.”
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the Poisson rates, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters.

Variance Calculation
Variance Calculation Method
Select among the two methods for calculating the V0 variance component (see the documentation above for
details).
•

Using Assumed True Rates
For this choice, the variance component V0 is based the values entered for λ1 and λ2.

•

Fixed Marginal Total or REML
This method assumes a fixed number of events. This method gives the same result as that derived using
restricted maximum likelihood estimation.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
inferiority when in fact the treatment mean is non-inferior.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when rejecting the null hypothesis of inferiority
when in fact the treatment group is not inferior to the reference group.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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μ(t) (Average Exposure Time)
μ(t) (Average Exposure Time)
Enter a value (or range of values) for the average exposure (observation) time for each subject in each group. A
value of one is commonly entered when exposure times are all equal. The range is μ(t) > 0. You can enter a single
value such as 1 or a series of values such as 0.8 0.9 1 or 0.8 to 1.2 by 0.1.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
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R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
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R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size
RU (Upper Equivalence Limit)
Enter the upper equivalence limit for the ratio of the two Poisson event rates (λ2 / λ1). This value is entered as a
ratio, not a percentage. When the ratio of the Poisson event rates is between this value and RL, the two rates are
said to be 'equivalent'. This value must be greater than one. Common choices are 1.1, 1.2, 1.25, and 1/RL. If you
enter '1/RL', RU will be calculated from RL as RU = 1/RL. The choice '1/RL' is popular because RL and RU =
1/RL are limits that are of equal magnitude on the log scale.
RL (Lower Equivalence Limit)
Enter the lower equivalence limit for the ratio of the two Poisson event rates (λ2 / λ1). This value is entered as a
ratio, not a percentage. When the ratio of the Poisson event rates is between this value and RU, the two rates are
said to be 'equivalent'. This value must be less than one. Common choices are 0.8, 0.9, and 1/RU. If you enter
'1/RU', RL will be calculated from RU as RL = 1/RU. The choice '1/RU' is popular because RU and RL = 1/RU
are limits that are of equal magnitude on the log scale.
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λ1 (Event Rate of Group 1)
Enter a value (or range of values) for the mean event rate per time unit in group 1 (control).
Example of Estimating λ1
If 200 patients were exposed for 1 year (i.e. t1 = 1 year) and 40 experienced the event of interest, then the mean
event rate would be λ1 = 40/(200*1) = 0.2 per patient-year. If 200 patients were exposed for 2 years (i.e. t1 = 2
years) and 40 experienced the event of interest, then the mean event rate would be λ1 = 40/(200*2) = 0.1 per
patient-year.
λ1 is used with λ2 to calculate the event rate ratio as λ2 / λ1. The range is λ1 > 0. You can enter a single value
such as 1 or a series of values such as 1 1.2 1.4 or 1 to 2 by 0.5.
Enter λ2 or Ratio for Group 2
Indicate whether to enter the Group 2 event rate (λ2) directly or the event rate ratio (λ2 / λ1) to specify λ2. The
event rate ratio is calculated from λ2 and λ1 as λ2 / λ1.
λ2 (Event Rate of Group 2)
Enter a value (or range of values) for the mean event rate per time unit in group 2 (treatment).
Example of Estimating λ2
If 200 patients were exposed for 1 year (i.e. t1 = 1 year) and 40 experienced the event of interest, then the mean
event rate would be λ2 = 40/(200*1) = 0.2 per patient-year. If 200 patients were exposed for 2 years (i.e. t1 = 2
years) and 40 experienced the event of interest, then the mean event rate would be λ2 = 40/(200*2) = 0.1 per
patient-year. λ1 is used with λ2 to calculate the event rate ratio as λ2 / λ1. The range is λ2 > 0. You can enter a
single value such as 1 or a series of values such as 1 1.2 1.4 or 1 to 2 by 0.5.
λ2 / λ1 (Ratio of Event Rates)
This is the (assumed, known, true) value of the ratio of the two event rates, λ1 and λ2, at which the power is to be
calculated. The event rate ratio is calculated from λ1 and λ2 as λ2 / λ1. The range is λ2 / λ1 > 0 and RL < λ2 / λ1
< RU. You can enter a single value such as 1 or a series of values such as 0.9 0.95 1 1.05 1.1 or 0.9 to 1.1 by 0.05.
φ (Dispersion)
Enter a value or series of values for the anticipated dispersion. Dispersion values lower than 1 indicate underdispersion, which implies the variance is less than the mean. Dispersion values greater than 1 indicate overdispersion, which implies the variance is greater than the mean. If over-dispersion or under-dispersion are not
anticipated, enter a value of 1. You can enter a single value such as 1 or a series of values such as 0.9 0.95 1 1.05
1.1 or 0.9 to 1.1 by 0.05.
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Example 1 – Calculating Sample Size
Researchers wish to determine whether the average Poisson rate of those receiving a new treatment is equivalent
to a current control. The average exposure time for all subjects is 2.5 years. The two treatments will be considered
equivalent if the event rate ratio is between 0.8 and 1.25. The event rate of the control group is 2.2 events per
year. The researchers would like to examine the effect on sample size of a range of treatment group event rates
from 1.9 to 2.5. Over-dispersion is not anticipated.
The desired power is 0.9 and the significance level will be 0.025. The variance calculation method used will be
the method where the assumed rates are used.

Setup
This section presents the values of each of the parameters needed to run this example. First load the Equivalence
Tests for the Ratio of Two Poisson Rates procedure window from the menus. You may then make the
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Variance Calculation Method .................. Using Assumed True Rates
Power ...................................................... 0.90
Alpha ....................................................... 0.025
μ(t) (Average Exposure Time) ................ 2.5
Group Allocation ..................................... Equal (N1 = N2)
RU (Upper Equivalence Limit) ................ 1.25
RL (Lower Equivalence Limit) ................. 0.8
λ1 (Event Rate of Group 1) ..................... 2.2
Enter λ2 or Ratio for Group 2 ................. λ2 (Event Rate of Group 2)
λ2 (Event Rate of Group 2) ..................... 1.9 to 2.5 by 0.1
φ (Dispersion) ......................................... 1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Equivalence Tests of the Ratio of Two Poisson Rates
H0: λ2 / λ1 ≤ RL or λ2 / λ1 ≥ RU vs.
H1: RL < λ2 / λ1 < RU
Variance Calculation Method: Using Assumed True Rates

Power
0.90012
0.90057
0.90001
0.90039
0.90047
0.90059
0.90045

N1
704
246
126
95
118
198
396

N2
704
246
126
95
118
198
396

N
1408
492
252
190
236
396
792

Average
Exposure
Time
μ(t)
2.50
2.50
2.50
2.50
2.50
2.50
2.50

Grp 1
Cntrl
Event
Rate
λ1
2.20
2.20
2.20
2.20
2.20
2.20
2.20

Grp 2
Trt
Event
Rate
λ2
1.90
2.00
2.10
2.20
2.30
2.40
2.50

Event
Rate
Ratio
λ2 / λ1
0.864
0.909
0.955
1.000
1.045
1.091
1.136

Lower
Equiv.
Limit
RL
0.800
0.800
0.800
0.800
0.800
0.800
0.800

Upper
Equiv.
Limit
RU
1.250
1.250
1.250
1.250
1.250
1.250
1.250

Dispersion
φ
1.00
1.00
1.00
1.00
1.00
1.00
1.00

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
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Report Definitions
Power is the probability of rejecting the null hypothesis when it is false.
N1 and N2 are the number of subjects in groups 1 and 2, respectively.
N is the total sample size. N = N1 + N2.
μ(t) is the average exposure (observation) time across subjects in both groups.
λ1 is the event rate per time unit in Group 1 (control).
λ2 is the event rate per time unit in Group 2 (treatment).
λ2 / λ1 is the (known, true, assumed) ratio of the two event rates.
RL and RU are the respective lower and upper equivalence limits for the event rate ratio.
Dispersion (φ) is the dispersion parameter (φ > 1 implies over-dispersion, φ < 1 implies under-dispersion).
Alpha is the probability of rejecting the null hypothesis when it is true.
Summary Statements
For an equivalence test of H0: λ2 / λ1 ≤ 0.800 or λ2 / λ1 ≥ 1.250 vs. H1: 0.800 < λ2 / λ1 <
1.250, and using the variance calculation method with assumed true rates, samples of 704 and
704 subjects with average exposure time 2.50 achieve 90.012% power to detect an event rate
ratio λ2 / λ1 of 0.864 when the event rate in group 1 (λ1) is 2.20, the event rate in group 2
(λ2) is 1.90, the dispersion is 1.00, and the significance level (alpha) is 0.025.
Dropout-Inflated Sample Size

Dropout Rate
20%
20%
20%
20%
20%
20%
20%

──── Sample Size ────
N1
N2
N
704
704
1408
246
246
492
126
126
252
95
95
190
118
118
236
198
198
396
396
396
792

Dropout-Inflated
Enrollment
──── Sample Size ────
N1'
N2'
N'
880
880
1760
308
308
616
158
158
316
119
119
238
148
148
296
248
248
496
495
495
990

Expected
Number of
───── Dropouts ─────
D1
D2
D
176
176
352
62
62
124
32
32
64
24
24
48
30
30
60
50
50
100
99
99
198

Definitions
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the
course of the study and for whom no response data will be collected (i.e. will be treated as "missing").
N1, N2, and N are the evaluable sample sizes at which power is computed. If N1 and N2 subjects are evaluated
out of the N1' and N2' subjects that are enrolled in the study, the design will achieve the stated power.
N1', N2', and N' are the number of subjects that should be enrolled in the study in order to end up with N1,
N2, and N evaluable subjects, based on the assumed dropout rate. After solving for N1 and N2, N1' and N2'
are calculated by inflating N1 and N2 using the formulas N1' = N1 / (1 - DR) and N2' = N2 / (1 - DR), with
N1' and N2' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., Shao, J., and Wang, H.
(2008) pages 39-40.)
D1, D2, and D are the expected number of dropouts. D1 = N1' - N1, D2 = N2' - N2, and D = D1 + D2.

This report shows the sample sizes for the indicated scenarios.
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Plots Section

This plot represents the required sample sizes for various values of λ2.
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Example 2 – Validation using Zhu (2016)
Zhu (2016) presents an example (see Supplementary Table 3) of solving for sample size where the event rates are
both 1.0, the dispersion parameter is 1.0, the average duration is 0.7, the equivalence limits are 0.9 and 1.1111 (1 /
0.9), the power is 0.8, and the Type I error rate is 0.025.
The calculated total sample sizes are 5410 and 5418 for the Assumed True Rate and Fixed Marginal Total or
REML variance calculation methods, respectively.

Setup
This section presents the values of each of the parameters needed to run this example. First load the Equivalence
Tests for the Ratio of Two Poisson Rates procedure window from the menus. You may then make the
appropriate entries as listed below, or open Example 2 (a or b) by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Variance Calculation Method .................. Using Assumed True Rates (2nd run: Fixed Marginal Total or REML)
Power ...................................................... 0.80
Alpha ....................................................... 0.025
μ(t) (Average Exposure Time) ................ 0.7
Group Allocation ..................................... Equal (N1 = N2)
RU (Upper Equivalence Limit) ................ 1/RL
RL (Lower Equivalence Limit) ................. 0.9
λ1 (Event Rate of Group 1) ..................... 1.0
Enter λ2 or Ratio for Group 2 ................. λ2 / λ1 (Ratio of Event Rates)
λ2 / λ1 (Ratio of Event Rates)................. 1
φ (Dispersion) ......................................... 1.0

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Equivalence Tests of the Ratio of Two Poisson Rates
H0: λ2 / λ1 ≤ RL or λ2 / λ1 ≥ RU vs.
H1: RL < λ2 / λ1 < RU
Variance Calculation Method: Using Assumed True Rates
Grp 1
Cntrl
Event
Rate
λ1
1.00

Grp 2
Trt
Event
Rate
λ2
1.00

Event
Rate
Ratio
λ2 / λ1
1.000

Lower
Equiv.
Limit
RL
0.900

Upper
Equiv.
Limit
RU
1.250

Dispersion
φ
1.00

Alpha
0.025

Variance Calculation Method: Fixed Marginal Total or REML
0.80001
2709
2709
5418
0.70
1.00

1.00

1.000

0.900

1.250

1.00

0.025

Power
0.80012

N1
2705

N2
2705

N
5410

Average
Exposure
Time
μ(t)
0.70

The sample sizes calculated in PASS match those of Zhu (2016) exactly.
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